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Product Names and Abbreviations
This documentation space references the following products and abbreviations:

• Symdump
• Endevor
• InterTest
• Roscoe
• Panvalet
• Librarian
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SymDump Help
SymDump provides extensive online documentation and context-sensitive help. You can request online help anytime
while using SymDump by clicking the Help menu.

Introduction
SymDump is a single graphical user interface for SymDump System, SymDump for CICS, and SymDump Batch.

Release Notes
The InterTest and SymDump Eclipse User Interfaces (UI) contain a group of views that provide all the functions you need
to debug your programs.

SymDump Client for Eclipse helps you identify and resolve mainframe batch dumps as quickly as possible within a easy to
use Eclipse interface, increasing application stability and reliability.

SymDump provides:

• Comprehensive diagnostic information for batch abnormal endings (ABENDs) in the testing and production
environments.

• Concise reports to help find and fix application failures in mainframe batch programs, reducing impact on development
schedules or affect application performance.

• Root cause analysis of problems and a suggested course of action, enabling a swift, informed response that can
increase application reliability and help you consistently meet your SLAs.

SymDump offers intelligent support for a variety of mainframe databases, comprehensive reporting and other capabilities
to enable your enterprise to quickly trace the flow of unfamiliar code to pinpoint performance problems, and debug
programs before and during production.

About SymDump
You can perform the following tasks using SymDump:

• Resolve system and application abends.
• Display the dump information in an easy-to-read format. 
• Display the system dumps captured from jobs, with specific environmental information for z/OS, CICS, MQSeries,

JES2, DB2, IMS, Datacom, IDMS and Roscoe Interactive Environment. 
• Reports on all abends with special symbolic support for applications written in COBOL, PL/I, and Assembler. 
• View detailed reports, formatted storage areas, and formatted control blocks that aid systems and application

programmers to quickly diagnose and correct problems.

The online help system describes how to use the commands and options available on SymDump.

SymDump offering is Eclipse Ready™. This offering can be installed and used with other Eclipse 3.6-based offerings.

Main Window
When you start SymDump, the main window displays a set of tabbed sections called views, the main menu bar, and the
main toolbar.

Each view on the main window contains a set of items relevant to that particular view. For example, the Error Log view
contains a list of all error logs for the current session. Also, each view contains a toolbar with a set of toolbar buttons
relevant to that view. The Minimize, Maximize, and Close toolbar buttons are common to all views. The toolbar buttons
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help manage the items within that particular view. For example, the Profiles view toolbar buttons let you add, delete, and
configure profiles (or sessions) available on the Profiles view.

Audience
This online help system is intended for application and system programmers who resolve abends and manage dump
captures and retentions.

New users can use the online help to become familiar with the features of the user interface.

Navigation
Icons on the toolbar are shortcuts for frequently used commands on a menu. Use the following icon on the Main Toolbar to
print open programs in the Program Listing area.

Icon Description
Prints the content of the active program in the Program Listing
area.

Main Menu Bar
The main menu bar on the SymDump main window contains the following menus.

File Menu
Use the commands on the File menu to close or print Program Listing views, import and export the current set of
profile settings, or exit or restart the application.

SymDump Menu
Use the commands on the SymDump menu to add new server connections or refresh the status of existing server
connections.

Window Menu
Use the commands on the Window menu to show a particular view, reset how views are displayed, and set your
preferences for SymDump.

Help Menu
Use the commands on the Help menu to access online help, cheat sheets, shortcut keys, and product version
information.

File Menu
Use the commands on the File menu to close or print Program Listing views, import and export the current set of profile
settings, or exit or restart the application.

Import
Imports an exported profile settings file to define a new server connection for a batch, CICS, or System project
using the Import dialog.

Export
Exports export profiles from SymDump to any shared resource using the Export dialogs.

Restart
Closes and restarts SymDump.

Exit
Closes all activities and exits SymDump.
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SymDump Menu
Use the commands on the SymDump menu to add new server connections or refresh the status of existing server
connections.

Add Server
Adds a new connection to the server using the New Server Connection dialog.

Refresh Server
Refreshes the status for all available server connections in the Profiles view.

NOTE
The Refresh Server option is enabled only after a server is added or selected in the Profiles view.

Window Menu
Use the commands on the Window menu to show a particular view, reset how views are displayed, and set your
preferences for SymDump.

Show Views
Lists the available views. To open a particular view, select that view from the menu.

Reset Perspective
Changes the current layout of views to the default layout.

Customize perspective
Allows you to set the default preferences for the current perspective. For example, SymDump perspective.

Show perspective
Allows you to choose a perspective from the list of perspectives displayed in the Show Perspective dialog.

Save perspective As
Allows you to save the current layout of views as a named perspective that can be reused.

Preferences
Configures the behavior of SymDump based on the settings you define using the Preferences dialog.

Help Menu
Use the commands on the Help menu to access online help, cheat sheets, shortcut keys, and product version information.

Help Contents
Opens an external Help browser window and displays a top-level link to SymDump online documentation, which
you can expand to display subsets of the documentation.

Search
Activates the internal online Help view and displays the Search panel. The Search panel lets you search for a text
in the SymDump online documentation.

Dynamic Help
Displays the help topics for the view that is currently in focus as you move from view to view.

Key Assist
Opens the Key Assist window where you can see shortcut key combinations. The Keys page on the Preferences
dialog lets you set your own shortcut key combinations for the commands in SymDump.

Cheat Sheets
Displays the Cheat Sheet view showing the Setting up Profiles View cheat sheet. Use the options in this cheat
sheet to get started with profiles. Cheat sheets guide you through the series of tasks or steps required to
accomplish a larger goal. You can open other cheat sheets available for use.
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About SymDump
Displays the About SymDump dialog, which provides information about the software and copyright, and contains
links to view details about plug-ins and configuration information.

Restore Default Shortcut Key Settings
Use these steps to restore SymDump shortcut keys for commands to their default setting.

Restoring all SymDump shortcut keys to the defaults lets you remove all changes made to specific shortcut key settings.

Follow these steps:

1. In the SymDump Eclipse plug-in, select Window, Preferences.
The Preferences dialog opens.

2. Select General, Keys.
The Keys dialog shows the preferences for shortcut keys.

3. Click Restore Defaults.
The Restore Keyboard Defaults dialog opens.

4. Click OK to restore all keys to the default settings.
5. Click OK to close the Keys dialog.

Exit SymDump
After you complete working with SymDump, you can exit the application.

To exit SymDump, select File, Exit.

When you exit, SymDump automatically saves the window layout. The next time you start SymDump, the saved layout is
redisplayed. The main window appears exactly as it was the last time you closed it.

If you change the default layout during a session, the changes are automatically saved as the current layout, including
open views and the main window layout.

Views
You can perform the following activities on the views available on the SymDump main window:

• Display Views
• Rearrange views
• Rearrange tabbed views
• Maximize views
• Minimize views
• Close a view
• Restore the default layout

These activities are applicable to all views except for the Program Listing area.

NOTE
Only one instance of a particular type of view can exist within SymDump at any given time.

Display Views
You can display views that are available but not displayed as part of the default layout of the SymDump main window.

Follow these steps:

1. Select Window, Show Views.
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A submenu displays a list of views.
2. Select the view you want to open.The SymDump main window shows the selected view.

NOTE
If you use the Alt+Shift+Q key sequence to open a view instead of selecting the Show View option from the
Window menu, a pop-up menu appears that lets you select and open the following views:

– Cheat Sheets—Alt+Shift+Q, H
– Error Log—Alt+Shift+Q, L
– Show View—Alt+Shift+Q,Q

Rearrange Views
You can rearrange the placement of views in the SymDump main window any time. You can do this by dragging and
dropping the view to place it in a different location. This action is called docking.

Follow these steps:

1. Click the title bar of the view you want to rearrange and drag the view across the SymDump main window.
The following cursors indicate where the view docks in relation to the view area beneath the cursor when you release
the mouse button:

Up Arrow
Docks above the view that appears beneath the cursor.

Down Arrow
Docks below the view that appears beneath the cursor.

Right Arrow
Docks to the right of the view that appears beneath the cursor.

Left Arrow
Docks to the left of the view that appears beneath the cursor.

Stacked Cursor
Docks the view in the same pane as the view that appears beneath the cursor. The view displays as a tab in the
pane.

Detached Cursor
Detaches the view from its location in the window. You can re-attach the view by clicking the tab of the detached
view, and dragging and dropping the view at its original location or at another location in the window.

2. Release the mouse button to dock the view in any position in the window. Drag the view's title bar to dock the view in
another position in the window.
The views are docked to the new positions in the SymDump main window.

Rearrange Tabbed Views
SymDump lets you rearrange the order of views in a tabbed notebook if you prefer to see the views differently on the main
window.

The following procedure illustrates how to rearrange the Index and Protsym views in a tabbed notebook.

Follow these steps:

1. Select Window, Reset Perspective.
2. Click OK on the Reset Perspective dialog.

The window perspective is reset to its original layout.
3. Select Protsym from the Show Views drop-down list on the Window menu.
4. Select Index from the Show Views drop-down list on the Window menu.
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5. Drag the Protsym title bar to the right of the Index tab until the cursor appears as a Stack cursor; then release the
mouse button.
The Protsym tab now appears to the right of the Index tab.

6. Drag the Index view tab to the right of the Protsym tab until the cursor is a Stack cursor and release the mouse button.
The Index view tab now appears to the right of the Protsym tab.

Maximize a View
All views have Maximize buttons on their toolbars that you can click to expand the view. You might want to maximize a
view to enlarge the view to see the details better or to focus on a particular area.

To enlarge the view, click the Maximize button on the right side of the menu bar of the view you want to maximize. To
restore the view, click the Restore button located on both the left side and the right side of the main window.

Minimize a View
All views have Minimize buttons on their toolbars that you can click to collapse the view. You might want to minimize a
view because you are not using it right now, but do not want to close it, as you will need it later.

To shrink the view, click the Minimize button on the right side of the menu bar of the view you want to minimize. To restore
the view, click the Restore button.

Close a View
To close a view, click the Close icon on the tab.

The selected view is removed from the main window.

Data views that contain tables with column headings will retain the column width size if you do not close the view before
exiting SymDump. If you resize the columns, close the view, and exit SymDump, then the resized values are not retained.

Restore the Default Layout
You can reset the main window layout to its default settings. When you reset the layout, the previous layout is no longer
available.

Follow these steps:

1. Click Window, Reset Perspective.
The Reset Perspective message appears.

2. Click OK.
The main window is reset to its default settings.

Program Listing Area

The Program Listing area in the main window is a framed area that displays any number of program listings in any layout.
Any number of programs can be opened within the Program Listing area at one time.

To view a program listing, the Protsym view must be populated with members from a Protsym first.

To populate the Protsym view, right-click any Protsym node in the Profile view and select Send Contents to Views.

To open the program listing, double-click the member name in the Protsym view.

Only one program listing can be visible at a time.
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As you view a new program listing, the previously selected program listing is hidden. To reactivate that program listing,
click its associated tab. You can activate only one program listing at a time.

You can arrange the program listings in this view so that they are stacked upon each other. You can tile all the program
listings in the Program Listing area so that each program listing is visible. You can also arrange program listings in a
combination of stacked and tiled layouts. You can resize the entire Program Listing area to accommodate the views in the
main window as necessary.

You can indirectly move the Program Listing area to different locations in the main window. You can do this by moving the
surrounding views to a different location. For example, to move the Program Listing area to the top, drag the views located
above the Program Listing area to another location on the main window.

You can maximize or minimize the Program Listing area. You can click the Close icon in individual program listings to
close them but you cannot close the Program Listing area. When there are no active program listings, the Program Listing
area appears as an empty rectangle.

Display a Hidden Program Listing
You may have several program listings open in the Program Listing area and want to look at one of them.

Click the tab of the listing you want to view on the Program Listing area. SymDump highlights the selected tab and brings
the listing into focus, indicating that it is the active view.

NOTE
The active listing in the Program Listing area controls the contents of other views on the SymDump as those
views are synchronized with the currently active listing in the Program Listing area.

Display a Hidden Program Listing Using Show List

If there are many listings open, SymDump may not have enough visual space to display all the tabs. You will then see the
symbol >> followed by a number. This is the Show List button that appears to the right of the tabs of individual program
listings in the Program Listing area.

The number represents the number of hidden programs. If you click the >> button, a pop-up menu displays all of the
programs that are opened. A highlighted name indicates the listing is hidden in the stack in the Program Listing area, and
clicking a highlighted name will bring that listing into focus.

The following diagram displays the names of the hidden views after clicking the >> button.

Add Items from the Program Listing Area to the Watch Data View
You can add keywords, memory expressions, or variables from COBOL, Assembler, or PL/I program listings to the Watch
Data view.

Follow these steps:

1. Locate and select the variable in the Program Listing area.
2. Right-click and select Add to Watch Data.

The Watch Data view refreshes to display the new variable.

NOTE
If you have selected a PL/I-based variable then the PL/I Locator Qualifier Selection dialog opens prompting you
to enter the locator qualifier. For more information, see Specify PL/I Locator Qualifiers for based Variables.
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Tile Program Listings
You can create two or more sets of listings in the Program Listing area. You can also resize the listings, but you cannot
drag other types of views into the Program Listing area.

Follow these steps:

1. Open at least two listings in the Program Listing area by double-clicking the file names on the Protsym view.

NOTE
The restricted cursor displays if you try to drop the view on top of any view or outside the SymDump main
window.

2. Dock the program listing on a directional arrow drop cursor so that two listings appear in the Program Listing area.

NOTE
You can resize each view and the entire Program Listing area to accommodate the program listing views and
other views as necessary.

3. (Optional) Observe the color of the program listing tabs.
Blue

Indicates that the program listing is currently active.
Default color

(depends on the system color scheme)
Indicates that the program listing was the last active view, but focus has been switched to another view outside
of the Program Listing area. This is important when working with other types of views such as the Outline view
whose contents are directly related to the last active program listing.

Example: The following illustration displays a layout of two tiled program listings:
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Reorder Tabbed Program Listings
You can rearrange the order of a tabbed group of listings in the Program Listing area. You can do this by dragging the title
bar of one of the tabbed views to the left or right of another view and releasing the mouse button when the cursor appears
as a stack cursor. The view you moved becomes the active program listing.

Close a Program Listing
You can close a program listing already opened or active in the Program Listing area.

Follow these steps:

1. Locate the tab for the program listing you want to close.
2. Click the Close icon on the tab.

The Program Listing area removes the tab corresponding to that program and refreshes to display the currently open
programs.

SymDump lets you close all of the program listings that are displayed in the Program Listing area at one instant.

To close all open program listings, select File, Close All.

SymDump Views
Use the views available on the main window to navigate through resources such as profiles, errors, Protsym indexes, and
program listings, and to navigate through the resources such as index files, dumps, and reports.

SymDump provides the following views:

CICS Trace View
Displays the various CICS trace formats in a table format, and lets you filter or change the display format of a
particular trace record.

Dump Tree View
Displays a structure in a tree view showing platform-dependent information that includes abending instruction,
program dumps, registers at abend, OS control blocks, CICS control blocks, internal warnings, and errors
generated by the platform.

Error Log View
Lists the internal warnings and errors generated by SymDump and provides options to sort or filter your data.

Index View
Lists the available dumps based on the repository or index files defined and selected in the Profiles view. You can
sort the dumps based on a particular category (column) in the Index view.

Outline View
Shows a tree view of the currently active Program Listing area and lists the structural elements.

Progress View
Shows the progress of a job or user task performed in the Profiles view, for example, requesting index list from the
server.

Profiles View
Shows the profiles added to SymDump in a tree view.

Protsym View
Shows a tabular view of batch and CICS projects, configured host name for each project, and the monitor status
for each program that you imported into a project. Protsym files are VSAM relative-record data sets (RRDS) used
to store symbolic information for use with other Broadcom testing tools products.
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Reports View
Allows you to generate and view the report from the data available under different files in the Dump Tree view.

Watch Data View
Keeps track of data, both structured and unstructured. Depending on what is being viewed, the contents in this
view may be similar to a memory dump or variables for a program listing at the time of abend and it allows you to
navigate the value of storage dumps and program variables.

Some views on the SymDump main window are synchronized with the currently active program in the Program Listing
area. When you select another program, several views refresh to display the relevant items available for that program. For
example, the SymDump main window shows Program 1 as an active program. Selecting Program 2 in the Program Listing
area refreshes the Outline view.

CICS Trace View

The CICS Trace view lets you view and filter the various CICS trace records.

To open the CICS Trace view, double-click the trace node of the dump tree structure for SymDump for CICS or
SymDump System.

The CICS Trace view displays the CICS trace records in a tabular format.

Record
Displays the record number of the CICS trace entry.

Text
Shows the display value for the trace record. You can view the trace records in the following formats:

• Abbreviated trace records
• Short trace records
• Full trace records

You can choose to switch between abbreviated, short, and full trace records, or hover over a trace record to show the
level of trace record that is not currently shown. You can view only one form of trace record short, full, or abbreviated at a
time.

Manage the CICS Trace View

Use the following icons on the CICS Trace view toolbar to perform the appropriate action:

Icon Description
Lets you filter the CICS trace records in the CICS Trace view
based on a set of filter fields.
Displays the list of records in the abbreviated trace record format.

Displays the list of records in the short trace record format.

Displays the list of records in the full trace record format.

Filter the Records in the CICS Trace View

You can filter the CICS trace records in the CICS Trace view based on a set of filter fields.
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Follow these steps:

1. Right-click and select Set Filter in the CICS Trace view.
The Filter dialog opens.

2. Select one of the following filter fields and type an appropriate filter value:
TASK

Filters the contents in the CICS Trace view and displays only those CICS trace records that match the task
number you typed.

TCB
Filters the contents in the CICS Trace view and displays only those CICS trace records that match the specified
Task Control Blocks (TCB).

Domain
Filters the contents in the CICS Trace view and displays only those CICS trace records that match the specified
Domain value.

Trace ID
Filters the contents in the CICS Trace view and displays only those CICS trace records that match the trace point
identifier you typed.

Module
Filters the contents in the CICS Trace view and displays only those CICS trace records containing the matching
CICS module name without the DFH prefix. The module is displayed in the trace without the leading DFH
characters, so type the name excluding the leading DFH characters.

DATA
Filters the contents in the CICS Trace view using a data filter and displays only those CICS trace records
containing matched data as specified in the filter. Records that are not available in the currently selected view but
contain matching data are also displayed.

3. Check the Apply Filter Selections box and then click OK.
The CICS trace records are displayed based on the filter applied.

Display the Records in the Abbreviated Trace Record Format

To display any trace record in the abbreviated format, click the Abbrev icon on the CICS Trace view toolbar or the View
Menu icon on the CICS Trace view and select Abbrev.

All the trace records in the CICS Trace view are displayed in the abbreviated format.

To display a particular trace record in the abbreviated format, right-click the cell of the CICS trace record entry in the CICS
Trace view and select Abbreviated View.

The selected trace record appears in the abbreviated format.

NOTE
If you select the cell of a particular CICS trace record entry that is already shown in the abbreviated format, the
Abbreviated option is not available for a right-click action.

Display the Records in the Short Trace Record Format

To display any trace record in the short format, click the Short icon on the CICS Trace view toolbar or click the View Menu
icon on the CICS Trace view and select Short.

All the trace records in the CICS Trace view are displayed in the short format.
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To display a particular trace record in the short format, right-click the cell of the CICS trace record entry in the CICS Trace
view and select Short View.

The selected trace record appears in the short format.

NOTE
If you select the cell of a particular CICS trace record entry that is already shown in the short format, the Short
option is not available for a right-click action.

Display the Records in the Full Trace Record Format

To display any trace record in the full format, click the Full icon on the CICS Trace view toolbar or click the View Menu
icon on the CICS Trace view and select Full.

All the trace records in the CICS Trace view are displayed in the full format.

To display a particular trace record in the full format, right-click the cell of the CICS trace record entry in the CICS Trace
view and select Full View.

The selected trace record appears in the full format.

NOTE
If you select the cell of a particular CICS trace record entry that is already shown in the full format, the Full
option is not available for a right-click action.

Display a CICS Trace Address in the Watch Data View

You can display a storage address from the CICS Trace view by adding it to the Watch Data view.

Follow these steps:

1. Double-click the row of the CICS Trace item whose address is to be added.
The Add to Watch Data dialog that contains the CICS Trace line from the row in the CICS Trace view displays.

2. Edit or accept the address displayed in the Add to Watch Data dialog. Click Finish.
The storage contents at the specific address are added as a row in the Watch Data view.

NOTE
If the address is not available in the dump, a message dialog displays. Click OK to exit the dialog.

Dump Tree View

The Dump Tree is a hierarchical view that displays all of the information available for the selected dump.

In this view, tree branches can be expanded or collapsed to display only the desired data, enabling you to drill down into
an area of interest while ignoring data that you consider less helpful.

Double-click a job name/task name or a program name in the Index view to load the dump report and build the dump tree.
The Dump Tree includes tree branches or nodes for formatted reports generated at capture time, programs that were
loaded at the time of the abend, and various types of control blocks.

Display Dump Information

The Dump Tree view lets you display all of the high-level information for a selected dump, then drill down into an area of
interest while ignoring data that you consider less helpful in the dump.
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Follow these steps:

1. Locate the dump you want to display in the Index view.
2. Select and double-click the job name (or program name) in the Index view whose information you want to see.

The Dump Tree shows all of the information available for the selected dump.

Display Reports

When a dump is captured, the repository data set is populated with information in a report format about your system, the
abending address space, and other environmental information as defined by your installation.

The Dump Tree View provides a hierarchical view of the contents of the report.

The Loaded Programs node (SymDump System) or the Programs nodes in the Dump Tree view contains an entry for
each load module found in the captured dump. You can view these load modules using a storage dump format.

Follow these steps:

1. Display program names by expanding the Loaded Programs node or the Abend Statement node in the Dump Tree
view.
The expanded node displays all the programs in the dump.

2. Double-click the program name whose module you want to see in dump format.
The Reports view displays the dump.

Close Dumps

You can close the dumps when you are no longer viewing them.

When one or more dumps are open, you can close the dumps by selecting the Close Dump option.

Follow these steps:

1. Select one or more dumps that you want to close.
2. Right-click and select Close Dump.

The Confirm Close dialog displays.
3. Click Yes.

The selected dump or dumps are closed. Closing the dump also closes the respective reports, variables in the Watch
Data View, Program Listings and all other information related to the Dump or Dumps.

Alternatively, you can click the View Menu icon on the Dump Tree view and select Close Dump to close the selected
dump (or multiple dumps). If you do not want to view the Confirm Close dialog, select the Always close dumps without this
prompt check box.

Close Dump Tree View

You can close the Dump tree view by closing the Dump tree tab.

Follow these steps:

1. Select Close Dump icon on the Dump tree View tab.
The Confirm Close Dialog appears.

2. Click Yes.
The Dump tree view is closed with the Dumps, report view, and other related information.

NOTE
Closing the Dump tree view closes all the open dumps, respective reports, variables in the Watch Data View,
Program Listings and all other information related to the dump or dumps.

 18



 SymDump® Eclipse Help 11.0

Add Items from the Dump Tree view to the Watch Data View

You can add keywords, memory expressions, or variables from COBOL, Assembler, or PL/I program listings from the
Dump Tree view to the Watch Data view.

You can use the following procedure when adding application data to the Watch Data view.

Follow these steps:

1. Locate and select any statement under the system dumps in the Dump Tree view.
2. Right-click and select Add to Watch Data.

The Watch Data view refreshes to display the new variable.

Map Items to Watch Data View

You can map selected items under a particular node in the Dump Tree to the Watch Data view. You can use the map data
option if you want to add system data when using SymDump System.

Follow these steps:

1. Select Window, Show Views, Dump Tree to display the Dump Tree view.
2. Right-click the node corresponding to the item you want to map and select Map Data.

The Watch Data view refreshes to display the mapped node in a structured format. You can expand or collapse the
tree in the Watch Data view to review the mapped contents.

Error Log View

The Error Log view captures and displays all internal trace records, other informational messages and errors generated by
the platform.

SymDump writes this information to a log file created in the metadata subdirectory of your workspace. The Error Log view
shows the content of this file and provides options to sort or filter your data.

When new events are logged, the application automatically highlights the Error Log view.

You can click the icons on the Error Log view toolbar to export, import, delete, and open a selected event. You can also
use the Clear Log Viewer and the Restore Logs icons to obtain the latest events generated for an active program.

Error Log View Toolbar

Use the Error Log view toolbar to perform the following actions:

• Export all existing errors displayed in the Error Log view to your computer or network. Locate the folder where you
want to save the selected log and click Save in the Save As dialog.

• Import an error log file into SymDump log file you want to import and click Open in the Open dialog.
• Remove all the errors displayed in the Error Log view temporarily. You can reload the errors anytime you want.
•  Delete the errors displayed in the Error Log view permanently.

NOTE
You cannot reload errors after they are deleted.

• Show the details of the selected error in the Event Details dialog.
• Show the details of the selected error in the Event Details dialog.
• Reload all errors that were temporarily removed into the Error Log view.
• Show a dropdown menu with options to filter the errors in the Error Log view.
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You can also perform the tasks by right-clicking any row in this view and selecting an appropriate option.

Index View

The Index view lists the available dumps based on the repository or index files defined (using Add Data Set) and selected
in the Profiles view.

SymDump System uses a repository or an index file to maintain a record of all captured dumps. The index view can be
populated from a combination of different repositories or index files that include all SymDump products.

The Index view displays the following details of an index in a tabular format:

Jobname/Task
Specifies the job name that produced the dump.

Program
Specifies the name of the abending program.

Offset
Specifies the offset into the program at the time of the dump.

ABEND
Specifies the Abend code.

Data Set Name
Specifies the data set name of the repository or index for the selected dump.

Date
Specifies the date the abend occurred.

Time
Specifies the time the abend occurred.

UserID
Specifies the user who was running the abending task.

Lock
Indicates whether the dump is locked or held.

System/Region
Displays the name of the system on which the abending task was running.

When you hover the mouse cursor over the leftmost column over an entry in this view, a short description of the entry
appears as a tooltip with information about the fields that are unique for the type of entry being viewed.

Populate the Index View

The contents of the dumps are displayed in the Index view as a selection list that includes details about each captured
dump. This lets you locate the desired dump easily before selecting it for viewing.

Follow these steps:

1. Right-click a repository or index data set under SymDump Batch, SymDump CICS, or SymDump System in the
Profiles view and select Send Content to Views.

NOTE
If the Profiles view is not visible, click Window, Show Views, Profiles to display the Profiles view.The Logon
Connection dialog opens.

2. Type your mainframe login and password, and click OK.
The Index view displays the job names and other details of all the dumps in the selected dump repository or index.
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Data View Dialogs

The Data View Array dialog displays a list of valued items that are part of a variable that occurs or is a child of a variable
that occurs.

This dialog displays all the occurrences of a selected array in a tabular format:

Array occurrence values
Displays the occurrence numbers or subscripts for the element displayed in that row. COBOL values are one-
based and PL/I values are zero-based.

Display value
Shows the display value for this occurrence.

Hex value
Shows the hex value for this occurrence.

The Data View Array dialog is used for display only.

Arrange the System Dumps in the Dump Index

To sort the system dumps based on a particular category, click the corresponding column header.

The Index view arranges the system dumps in ascending order based on the selected category.

Manage the Dump Index

You can control the dumps displayed in the Index view. The toolbar icons in this view allow you to delete multiple dumps,
lock multiple dumps to prevent deletions, and unlock them to undo a lock. You can select a dump to view or you can view
the electronic notepad provided with each dump.

Click the following toolbar icons to perform relevant actions in the Index view:

Click Description
Lock a dump to prevent accidental deletion in the dump index.

Unlock previously locked dump indexes in the Index view to allow
deletion.
Delete an unused dump index from the Index.

NOTE
Double clicking any dump in the Index view formats the dump into a Dump Tree View.

Lock a Selected Dump

You can lock a single dump entry or multiple dump entries to prevent accidental deletion in the Index view.

Follow these steps:

1. Open the Index view.
2. Right-click the dump entry and select Lock Dump.
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NOTE
You can select multiple dump entries using Ctrl-click or Shift-click. If you select one of multiple duplicate
entries, all duplicate entries get locked.

This action locks the selected dump entry and changes the value under the Lock column in the Index view.
For SymDump Batch and SymDump System, the value under the Lock column shows the user ID of the user who
locked that dump. For SymDump CICS, the value under the Lock column changes to Locked.

Unlock a Locked Dump

You can unlock a previously locked dump entry or multiple dump entries in the Index view to allow deletion.

Follow these steps:

1. Open the Index view.
2. Right-click the dump entry and select Unlock Dump.

NOTE
You can select multiple dump entries using Ctrl-click or Shift-click. If you select one of multiple duplicate
entries, all duplicate entries get unlocked.

This action clears the value under the Lock column in the Index view.

Delete a Selected Dump

SymDump allows you to delete multiple dump entries from the Index. Before performing a deletion, verify that the selected
dump entries are not locked. You cannot delete a dump entry if it is already open in the main window.

Follow these steps:

1. Open the Index view.
2. Right-click the dump entry and select Delete Dump.

NOTE
You can select multiple dump entries using Ctrl-click or Shift-click. A delete request on one of multiple
duplicate entries results in the deletion of the first matching entry in the Index.

This action deletes the dump from the system and removes the selected dump entry from the Index.

Refresh the Dumps in the Index View

You can reload the Index View items from the mainframe so that the Index view is populated with the details of the dumps
that have been added, deleted, locked, or unlocked. You can also check for new dumps that you may want to add to the
Watch Data view.

To refresh the Index view, click the Refresh Index View icon in the Index view.

The Index view reloads to show the most current status for all available items.

Outline View

The Outline view displays an outline of the program listing that is highlighted in the Program Listing area and lists the
structural elements of the program as nodes in a tree view.
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The Outline view contains a top level node for each main section of a program. For example, a COBOL program in
the Program Listing area shows the four divisions of the COBOL program in the Outline view when you first open the
program. For an Assembler listing, the Outline view shows all the top-level nodes.

When multiple programs are open in the Program Listing area and you click the tab showing the name of a program, the
Outline view refreshes to display the relevant items associated with the selected program.

Navigate to a Statement in a Program

You can quickly go to a statement or field in the program shown in the Program Listing area using the Outline view.

Follow these steps:

1. Display the program listing whose statement or field you want to see in the Program Listing area.
2. Select Window, Show Views, Outline view to display the Outline view, if it is not already displayed.
3. Click the plus sign next to a node to expand it.
4. Select a variable or label name.

SymDump repositions the program listing and highlights the statement corresponding to your selection.

Manage the Outline View

Click the following toolbar icons to perform relevant actions in the Outline view:

Click Description
Expands the tree for a node selected in the Outline view and
displays the subnodes, fields, or variables under it.
Narrows the expanded list of nodes in the Outline view.

Adds a variable selected in the Program Listing area or Outline
view to the Watch Data view in the Outline view.

Expand Trees in the Outline View

If you want to view the contents of all the programs in the Outline view, you can use the Expand All Trees toolbar icon on
the Outline view.

To quickly expand the tree to the left of a selected node under the main program listing, right-click that node and select
Expand Tree.

Collapse Trees in the Outline View

If you want to narrow the expanded list of items in the Outline view, you can use the Collapse All Trees toolbar icon on the
Outline view.

To quickly collapse the tree to the left of a selected node under a program, right-click that node and select Collapse Trees.

The Outline view collapses the selected node hiding the fields within the program.

Add Items from the Outline View to the Watch Data View

If you want to add variables directly from the Outline view to the Watch Data view, you can use the Add to Watch Data
option.
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Follow these steps:

1. Select Window, Show Views, Outline to display the Outline view.
2. Select an active program listing in the Program Listing area.

The Outline view refreshes to show the contents of the program listing.
3. Expand a label in the Outline view.

The Outline view displays the list of items under the selected label.
4. Select the variable that you want to add to the Watch Data view in the Outline view. Right-click and select Add to

Watch Data.
The Watch Data view refreshes to display the new variable.

Profiles View

You can use the Profiles view to manage servers, profiles, and data sets. You can create multiple profiles and data sets,
and you can also import and export saved profile settings.

When adding a data set to a selected profile, you can choose to add it as a default data set.

Modify Servers, Profile Settings, and Data Sets in the Profiles View

Follow these steps:

1. Verify that a server connection is available and active in the Profiles view.
2. Right-click the server name and select one of the following actions:

NOTE
The Profile view selectively displays right-click options for different nodes. The right-click actions that are
unavailable for the selected node are disabled. To view all available options, click the View Menu icon on the
Profiles view toolbar.

Expand Tree
Lets you expand the tree.

Collapse Tree
Lets you collapse the tree.

Add New Server
Opens the New Server Definition screen, so that you can add another server.

Refresh Server Status
Refreshes the server status.

Update Server
Opens the Update Server Definition dialog, so that you can make changes to either the name, host, port, or User
ID.

NOTE
You may choose to save your mainframe password. Check the Save Password box in the Update
Server Definition dialog if you want the application to preload the saved password into the Logon dialog
whenever you are prompted to enter your user ID and password. If you prefer to replace the saved
password with a new password anytime, click Clear Password. You can use a new password when you
log on.

Delete Server
Lets you delete the server and all its profiles, after confirmation.

Reset Server Password
Lets you reset the server password.
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Add Profile
Opens the New Profile Definition screen, where you can add another profile to your server. After you have
expanded the tree, you will see your default profile. Right-clicking the Default Profile opens a menu with the
preceding items with other options.

Update Profile
Opens the Update Profile Definition screen, where you can update your profile name.

Delete Profile
Lets you delete your profile, after confirmation.

NOTE
You can use Ctrl-click or Shift-click to delete multiple profiles.

Add Dataset
(available when you right-click the product name or Protsym)
Lets you add a fully qualified data set depending on the node.

NOTE
For SymDump System and SymDump Batch, you can choose to use the data set defined in the
product's installation defaults. Check the Use Default Data Set box to use the product-defined default
data set.

Update Dataset
(available when you right-click the data set name)
Lets you update the data set name.

Delete Dataset
(available when you right-click the data set name)
Lets you delete the selected data set name from the Profiles view.

NOTE
You can use Ctrl-click or Shift-click to delete multiple data sets.

Add Symbolic
(available when you right-click the data set name)
Allows you to add listings to the Protsym using the Load Listings into Protsym dialog.

Send Content to Views
Sends the contents of the selected files to the appropriate views. For example right-clicking a Protsym profile and
selecting Send content to views, populates the Protsym view with details of the Protsym data sets checked.

Display Options
Allows you to view the current installation options that are in effect and the product initialization status for the
batch, the System profiles in the Profiles view, and CICS profiles (CICS data sets) in the Profiles view.

Use Cheat Sheets
Cheat sheets are additional help options. Cheat sheets provide step-by-step instructions for performing tasks.
Cheat sheets also demonstrate some tasks such as opening a view from the main window.

Manage the Profiles View

You can add new server connections, and refresh or update existing server connections displayed in the Profile view
using the toolbar icons in this view.

Follow these steps:

1. Click the Profiles view tab to highlight the view's toolbar.
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NOTE
If the Profiles view is not visible, click Window, Show Views, Profiles to display the Profiles view.

2. Use the following icons on the Profiles view toolbar to perform the appropriate action:

Icon Description
Expands all the trees in the Profiles view and displays the
contents of all the nodes.
Collapses all the trees in the Profiles view and narrows the
expanded list of items.
Resets the password to a selected server connection.

Refreshes the status for all server definitions in the Profiles view.

Adds a new connection to the server using the New Server
Definition dialog.

Load Listings into a Protsym File

You can load program listings into the Protsym file using the load utility.

Follow these steps:

1. Select a data set name under the Protsym node in the Profiles view.
2. Right-click and select Add Symbolic.

The Load Listings into Protsym dialog opens showing the values for the following fields.
Server

Displays the name of the active server connection and the port number that is used to communicate with the z/OS
mainframe.

Protsym Dataset Name
Displays the name of the Protsym data set into which you want to load the program listings.

3. Enter the details in the following fields:
Listing Dataset

Specifies the name of the data set from which program listings will be loaded. Type a fully qualified data set name
for the source data set or select a name from the source data set dropdown list and then select the data set type.

NOTE
You can choose one of the following data set types: IBM PDS, IBM Sequential, Panvalet, Librarian, and
Endevor.

Member
Displays the members to be loaded into the Protsym file.
From

Specifies the first or only member from the range of members.
To

Specifies the last member to be loaded. Leave this field blank if you want to load only one member into
the Protsym file.

4. Click Finish.

This action loads the program listings from the source data set into the selected Protsym data set.
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Import Profile Settings

You can import profiles from a shared resource or from a source directory. Note that any Import action causes all of your
existing profiles to be replaced by the new profile settings file.

NOTE
You must import only previously exported Extensible Markup Language (XML) files into your project.

Follow these steps:

1. Select File, Import.
The Import dialog opens the Select page.

2. Expand the CA Testing Tools folder.
3. Select Profile and click Next.

The Import dialog opens the Profile Settings page.
4. Click Browse and locate the profile file or enter the path to the source folder on a computer or the network from which

you want to import the file.
The Destination Folder field gets populated with the path to the profile settings file.

5. Click Finish.
The application imports the profile file and prompts if you want to restart your program right away. A restart is required
for the imported profile settings to take effect.

Export Profile Settings

You can export profiles from Eclipse UI to any shared resource.

You must export the profile settings from your Profiles view as an Extensible Markup Language (XML) file. Other
SymDump users may import the exported profile settings file.

Follow these steps:

1. Select File, Export.
The Export dialog opens the Select page.

2. Expand the CA Testing Tools folder.
3. Select Profile and click Next.

The Export dialog opens the Profile Settings page.
4. Enter relevant details in the following fields:
[Required] Destination File

Specifies the path to the destination folder on a computer or the network where you want to store the profile
settings file.

[Optional] Overwrite Existing File
Overwrites an existing XML file with the profile settings file. Check this box to enable overwriting the existing
profile settings file.

5. Click Finish.
The application generates the profile settings file and saves it in the location you specified.

Expand Trees in the Profiles View

If you want to view the contents of all the programs in the Profiles view, you can use the Expand All Trees toolbar icon on
the Profiles view.
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To quickly expand the tree to the left of a selected node under the main program listing, right-click that node and select
Expand Tree.

Collapse Trees in the Profiles View

If you want to narrow the expanded list of items in the Profiles view, you can use the Collapse All Trees toolbar icon on the
Profiles view.

To quickly collapse the tree to the left of a selected node under a program, right-click that node and select Collapse Tree.

The Profiles view collapses the selected node hiding the fields within the program.

Log on to the Mainframe

You are prompted to supply your logon credentials whenever you request data from the server or send data to the server.

Follow these steps:

1. Select a data set name under Protsym in the Profiles view to populate the Protsym view with the storage data for
selected dumps.
OR
Select a data set name under batch, CICS, or System to populate the Index view with captured dumps.

2. Right-click and select Send content to views.
The Logon Connection dialog opens.

3. Enter your z/OS system user ID and password.
4. Check the Save Password box if you want to save your password. 

The application preloads the saved password into the Logon dialog whenever you are prompted to enter your user ID
and password. If you do not save it, you will be prompted for your password whenever you log on to the application.
Until the password is deliberately reset or a logon fails, you will be prompted for a user ID and password only when
you first use a server.

5. Click Finish to close the dialog.

Display Options

You can use the Display Options feature to view the installation options in effect for SymDump CICS data sets and
the product status. You can also view the options for SymDump Batch and SymDump System profiles.

Display Product Options

Follow these steps:

1. Select a Batch or a System profile.
2. Right-click the profile and select Display Product Options.

Based on the profile you selected following is displayed:
– For SymDump System, the options specified in the CADVTABL macro are displayed.
– For SymDump Batch, the options specified in the CAOETABL and CAOUDFRX macros are displayed.

Display PROTDMP Options

Follow these steps:

1. Select a CICS profile PROTDMP data set.
2. Right-click and select Display PROTDMP Options.
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The options specified for the selected CICS data set are displayed.

Send Content to Views

You can populate the Index view or the Protsym view with captured dumps or storage data respectively using the options
available in the Profiles view.

To populate the Protsym view with the storage data for selected dumps, double-click a data set name under Protsym in
the Profiles view.

To populate the Index view with the details of captured dumps, double-click a data set name under batch, CICS, or
System in the Profiles view.

Progress View
The Progress view shows the progress of a job or user operation performed in the SymDump views for example,
requesting an index list from the server.

The status of the Progress view changes each time a new action or operation is performed, for example when a member
in the Protsyms view is double clicked to display a report, the contents in the Progress view changes accordingly.

Manage the Statuses of Operations Displayed in the Progress View

Follow these steps:

1. Click the Progress view tab to highlight the view's toolbar.

NOTE
If the Progress view is not visible, click Window, Show Views, Progress to display the Progress view.

2. Use the following icons on the Progress view toolbar to perform the appropriate action:

Icon Description

Removes all the statuses of operations displayed in the Progress
view.

The following statuses are shown in the Progress view:

Getting Index list
Shows the progress of populating the Index view with dump indexes. If you double-click a data set under the
SymDump System profile in the Profiles view, the following status message shows in the Progress view:
Getting index list for the name of the data set@name of the server connection

Getting members
Shows the progress of populating the Protsym view with the storage data for selected dumps. If you double-click a
data set under any Protsym profile in the Profiles view, the following status message shows in the Progress view:
Getting members list for the name of the Protsym data set@name of the server connection

Refreshing status
Shows the progress of refreshing server connections. If you right-click any server and select Refresh Server
Status, the following status message shows in the Progress view:
Getting index list for the Refreshing status name of the server connection
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Set Preferences to Display the Progress View

You can set the preferences for the Progress view if you want to display the status of sleeping and system operations in
the Progress view.

Follow these steps:

1. Click the View Menu icon on the Profiles toolbar and select Preferences from the drop-down menu.
The Progress Preferences dialog opens.

2. Check the Show sleeping and system operations box and click OK.
The statuses of sleeping or system operations are now displayed in the Progress view.

NOTE
If there are no active operations, the Progress view shows the following message: No operations to display
at this time.

Remove All Finished Operations from the Progress View

You can delete the statuses of operations displayed in the Progress view to free up the memory space.

To delete the statuses of operations, click the Remove All Finished Operations toolbar icon on the Progress view.

This action removes all the statuses of operations from the Progress view.

Protsym View

The Protsym view displays the protsym member attributes. A Protsym file stores program listings and information that can
be used to map data areas to field names in the program.

The Protsym view displays the following information tabular format:

Member
Specifies the name of the program that was running.

Language
Specifies the type of the program that was running. Values include ASSEMBLER, COBOL, and PL/I.

Date
Specifies the date the program was compiled or assembled.

Time
Specifies the time the program was compiled or assembled.

Protsym
Displays the name of the Protsym data set.

The Protsym view displays multiple Protsym data set members in a layout. You can open any number of programs at one
time.

Open the Protsym View

You can open the Protsym view from the Profiles view.

Follow these steps:

1. Ensure that the Profiles view is visible.

NOTE
If the Profiles view is not visible, select Window, Show Views, Profiles.
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2. Right-click the Protsym file you want to view and select Send content to view.
The Logon Connection dialog opens, if SymDump has not already logged you on the mainframe.

3. Enter your z/OS system user ID and password and click Finish.

Arrange the Members in a Column

The Protsym view allows you to arrange the members in ascending or descending order. You can sort the items based on
the column data, for example members, in the Protsym view.

Follow these steps:

1. Open the Protsym view.
2. Click one of the column headers in the Protsym view:

Member
Sorts the members based on the program names.

Language
Sorts the members based on the type of the program.

Date
Sorts the members based on the date when the programs were created or modified

Time
Sorts the members based on the time when the programs were created or modified.

Protsym
Sorts the members based on the names of the Protsym data set.

Open Programs from the Protsym View

You can open programs from the Protsym view.

To open a program or a member in the Protsym view, right-click the member in the Protsym view and select Open Listing.

The selected program listing opens in the Program Listing area and is available for viewing.

You can open multiple programs in the Program Listing area. However, only one program can be active at a time.

Display a Program Listing in the Program Listing Area

To display a program listing, select the program member displayed in the Protsym view, right-click and select Open
Listing.

The selected program listing opens in the Program Listing area and is now available for viewing.

Refresh the Items in the Protsym View

You can reload the program members from the mainframe into the Protsym view if you want to view the most current
status for the program members available in the Protsym view. For example, new program members may occur that you
would want to add to the Protsym view.

To refresh the Protsym view, click the Refresh Protsym View icon on the Protsym view toolbar.

The Protsym view reloads to show the most current status for all available items.
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Reports View

Use the Reports view to generate and view reports from the data available under different files in the Dump Tree view.

Follow these steps:

1. Open the Dump Tree view.
2. Expand the branches in the tree.
3. Double-click an item to request a report.

The Reports view opens showing the details of the selected preformatted report. When you select multiple items from
the Dump Tree view, these reports will be added at the location in the Reports view corresponding to the location of
the item in the tree. The contents of this report will expand as multiple items are selected from the Dump Tree.
Only for SymDump Batch, the entire report is presented when the first request is made. The content of the individual
reports may vary by product and specific dumps.

NOTE
Some items in the tree do not represent a report. Double-clicking such items will have no effect on the
Reports view.

Add Storage Address from the Reports View to the Watch Data View

You can select a storage address from the Reports view to display the storage data at the address in the Watch Data
view.

Follow these steps:

1. Display a report containing the details of a preformatted report in the Reports view.
2. Select an address in the report that is to be added to the Watch Data view.
3. Right-click and select Add Address to Watch Data View.

The storage address and the storage data is added as a row in the Watch Data view.

You can add multiple storage addresses to the Watch Data view. However, only one storage address can be added to the
Watch Data View at a time.

Copy the Contents in the Reports View

SymDump allows you to copy the details from the displayed report to a text editor for future storage.

Follow these steps:

1. Open the report you want in the Reports view.
2. Right-click and select Select All to select the entire report.

The details in the displayed report gets highlighted.
3. Right-click and select Copy to copy the report details.

The details in the displayed report are copied to the windows standard clipboard.
4. Open any text editor, paste the contents into a new file, and save the report details as a .txt file.

Watch Data View

The Watch Data view displays program variables, addresses, and system control blocks from the dump that you selected
to view.

This view displays attributes of the selected item in the Description column. For each posted item, the Watch Data view
displays the following details in a tabular format:
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Name
Displays the names of variables, addresses, or storage areas that have been sent to the Watch View.

Value
Shows the display value for the item. For program variables, the data description in the program dictates the
format of the value. If the item is a keyword, posted expression, or group item, there is no display value. The data
description shows a message related to the item.

Hex Value
Displays the hexadecimal EBCDIC (Electronic Binary Coded Decimal Interchange Code) representation of the
value. The hex value and its length depend on the item declaration.

Description
Displays additional information about the item.

When you hover the mouse cursor over an element in this view, a short description of the entry appears as a tooltip with
information about the fields that are unique for the type of entry being viewed.

Open the Watch Data View

You can open the Watch Data view from the Dump Tree view or from the menu bar.

To open the Watch Data view, right-click any item on the Dump Tree and select Add to Watch Data view.

This action populates the Watch Data View with the storage data for selected dumps.

Manage the Watch Data View

You can control the mapped nodes displayed in the Watch Data view. The toolbar icons in this view allow you to expand or
collapse trees next to a selected node, or remove a selected item in the Watch Data view.

Click the following toolbar icons to perform relevant actions in the Index view:

Click Description
Deletes a selected item from the Watch Data view.

Expands the tree for a node selected in the Watch Data view and
displays the subnodes, fields, or variables under it.
Narrows the expanded list of nodes in the Watch Data view.

Adds a new entry of the previous storage address as a new row to
the Watch Data view
Adds a new entry of the subsequent storage address as a new
row to the Watch Data view.
Moves the selected item above the preceding item in the Watch
Data view.
Moves the selected item below the subsequent item in the Watch
Data view.

Add items to the Watch Data view

You can add keywords, memory expressions, or variables from COBOL, Assembler, or PL/I program listings to the Watch
Data view. Do one of the following:
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• Add items from the Dump Tree to the Watch Data view.
• Add items from the Outline view to the Watch Data view.
• Add items from the Program Listing area to the Watch Data view.
• Add storage address from the Reports view to the Watch Data view
• Add storage address to the Watch Data view

NOTE
You can also map data to the Watch Data view if you want to add system data when using SymDump System

Show Occurs Values

You can view the list of variable items that are part of a COBOL occurs clause by using the Data View Array dialog.

To open the Data View Array dialog, right-click the variable item within the occurs clause displayed in the Watch Data view
and select Show Occurs.

The Data View Array dialog displays a list of data item locations within the occurring field.

Display a Storage Address in the Watch Data View

You can display a storage address in the Watch Data view by adding it to the Watch Data view.

Follow these steps:

1. Double-click the row of the Watch Data item whose address is to be added.
This action causes a dialog that contains the Hex column data from the row in the Watch Data view.

2. Edit the address or accept the address displayed in the Add to Watch Data dialog. Click Finish.
The storage contents at the specific address are added as a row in the Watch Data view.

NOTE
If the address is not available in the dump, a message dialog opens. Click OK to exit the dialog.

Remove Items from the Watch Data View

You can review or remove keywords, memory expressions, or variables from the Watch Data view.

Follow these steps:

1. Select Window, Show Views, Watch Data to display the Watch Data view.
2. Right-click anywhere on the row corresponding to the item to delete and select Delete item.

The selected item is removed from the Watch Data view.

Expand Trees in the Watch Data View

If you want to view the contents of a mapped item in the Watch Data view, you must expand the node for that item.

To quickly expand a tree in the Watch Data view for a mapped item, right-click the node for that item in the Name column
and select Expand Trees.

The Watch Data view expands the selected node and displays the subnodes, fields, or variables under the expanded
node.
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Collapse Trees in the Watch Data View

After you have viewed the contents of a mapped item, you may want to collapse the tree of an expanded node in the
Watch Data view.

To collapse the tree, right-click the node in the Name column of the expanded item in the Watch Data view and select
Collapse Trees.

The Watch Data view collapses the node hiding the contents of the mapped item.

View Prior Storage in the Watch Data View

You can view prior storage by adding the previous storage address as a new entry to the Watch Data view.

To add a previous storage address to a Watch Data item, right-click the storage address in the Name column of the Watch
Data view and select Previous.

A new row is added to the Watch Data view. This new entry will start at the new address that is hex 600 bytes prior to the
current address.

View Subsequent Storage in the Watch Data View

You can display the subsequent storage address by adding it as a new row to the Watch Data view.

To add a new entry of a subsequent storage address to a Watch Data item, right-click the address in the Name column of
the Watch Data view and select Next.

A new row is added to the Watch Data view. This new entry will start at the address that is hex 600 bytes following the
current address.

Move a Selected Watch Data Item One Level Up

You can change the hierarchy level of items displayed in the Watch Data view. You can move a selected item above the
preceding item in the Watch Data view.

NOTE
You cannot move the first item in the Watch Data view one level up. The Up option is disabled or not available
for the first item.

To move a selected Watch Data item one level up, right-click the row in the Watch Data view and select Up.

The selected item has moved one level up in the Watch Data view.

Move a Selected Watch Data Item One Level Down

You can change the hierarchy level of items displayed in the Watch Data view. You can move a selected item below the
subsequent item in the Watch Data view.

NOTE
You cannot move the last item in the Watch Data view one level down. The Down option is disabled or not
available for the last item.

To move a selected Watch Data item one level below, right-click the row in the Watch Data view and select Down.

The selected item is moved below the subsequent item.
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Servers
SymDump relies on a server running on a z/OS mainframe to provide all mainframe services.

The SymDump server is installed with the mainframe component of Broadcom Testing Tools. It is started by submitting a
Broadcom supplied job to z/OS. The server continues to execute until an administrator issues a stop command or the job
gets cancelled.

Once started, the application uses a TCP/IP port number that enables SymDump to communicate with the z/OS
mainframe. A port number is assigned during the installation of the server. You must specify this port number when you
define a server connection.

Add a New Server Connection

Before you start to capture system dumps and display the dump information, you need to connect to a server.

Follow these steps:

1. Select SymDump, Add Server.
The New Server Definition dialog opens.

2. Type the details for the new server connection.
The following field values are required to create a new server connection:

Name
Specifies the name of the server connection. Valid values: upper and lowercase alphanumeric characters, special
characters, and embedded spaces.

Host
Specifies the z/OS host name assigned by your installation. This is the host name used for a TSO or CICS logon.

Port
Specifies the TCP/IP port number of the server.

User ID
Specifies your user ID for logging on to a z/OS system.

(Optional) Save Password
Specifies whether you want to save your password. If you save your password, the application preloads the saved
password into the Logon dialog whenever you are prompted to enter your user ID and password. If you do not
save it, you will be prompted for your password whenever you log on. Until the password is deliberately reset or
a logon fails, you will be prompted for a user ID and password only when you first use a server. Check this box to
save your password.

3. Click Finish.
The new server is created and added to the list of servers in the Profiles view. The Profiles view shows the details of
the new server.

Configure an Existing Server

You can configure the existing server definitions displayed on the Profiles view.

Follow these steps:

1. Right-click the server you want to configure and click Update Server in the Profiles view.
The Update Server Definition dialog opens.

2. Modify the details for the server that you want to configure.
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Name
Specifies the name of the server connection. Valid values: upper and lowercase alphanumeric characters, special
characters, and embedded spaces.

Host
Specifies the z/OS host name assigned by your installation. This is the host name used for TSO logon.

Port
Specifies the TCP/IP port number for the selected server.

(Optional) User ID
Specifies the user ID for logging on to a z/OS system. Enter your user ID in this field.

(Optional) Save Password
Specifies whether you want to save your password. If you save your password, the application preloads the saved
password into the Logon dialog whenever you are prompted to enter your user ID and password. If you do not
save it, you will be prompted for your password whenever you log. Until the password is deliberately reset or a
logon fails, you will be prompted for a user ID and password only when you first use a server. Check this box to
save your password.

Clear Password
Specifies that you do not want to save the stored password.

3. Click Finish.
The server definition is updated and the Profiles view shows the details of the modified server.

Reset Server Password
You can reset the password for any server connection listed in the Profiles view. Reset password clears the stored or
cached copy of the password used by SymDump. You may want to clear an already stored password if you have changed
your mainframe password. When SymDump is running, you are prompted to enter a password the first time you connect
to the server. This occurs during each session.

NOTE
You cannot change your mainframe password in SymDump.

Follow these steps:

1. Ensure that the Profiles view is visible.

NOTE
If the Profiles view is not visible, select Window, Show Views, Profiles.

2. Right-click the server connection whose password you want to reset, and then click Reset Password.

Refresh Server Status
You may want to refresh the status for all available server connections in the Profiles view.

To refresh the status of servers in the Profiles view, click the Refresh Server Status icon in the Profiles view.

The Profiles view reloads to show the most current status for all server connections.

Delete a Server Connection
You can delete a server from SymDump if you are not using it. You can delete multiple server connections from
SymDump.

Follow these steps:

1. Right-click the server you want to delete and select Delete Server in the Profiles view.
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NOTE
You can use Ctrl-click or Shift-click to delete multiple servers.

A confirmation dialog opens.
2. Click Yes.

The selected server connection is removed from SymDump and the Profiles view refreshes showing the list of
available server connections.

Add Profiles Connected to a Server

You can add any number of profiles to a server using the Profiles view. Adding profiles is useful for grouping data sets
together that are used for a common function, and then giving the profile a meaningful name.

Follow these steps:

1. Select a server to which you want to add a profile in the Profiles view.
2. Right-click and select Add Profile.

The New Profile Definition dialog opens.
3. Type a name for the new profile and click Finish.

The new profile is created and added to the list of profiles under the selected server.

Update Existing Profiles

Use the Update Profile Definition dialog to modify the name of an existing profile.

Follow these steps:

1. Right-click the profile and select Update Profile in the Profiles view.
The Update Profile Definition dialog opens.

2. Edit the name of the selected profile and click Finish.
The changes are saved and the Profiles view refreshes to show the updated profile name.

Delete Profiles
You can delete a particular profile or multiple profiles from a server using the Profiles view if you are not using it.

Follow these steps:

1. Right-click the profile to delete and select Delete Profile in the Profiles view.

NOTE
You can use Ctrl-click or Shift-click to delete multiple profiles.

The Confirm Delete dialog opens requesting you to confirm the deletion.
2. Click OK.

The profile is deleted from the server and the Profiles view refreshes to show the list of available profiles.

SymDump Data Sets
Dumps are stored in repositories maintained by each SymDump product. Their name varies by product as shown in the
following table:

Type Name
SymDump for CICS Prot Dump or PROTDMP
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SymDump Batch Printlib or PRTLIB
SymDump System Index

Add Dump Repository or Index Data Sets to a Profile

You can add any number of dump repository or index data sets to a profile as required by your project.

Follow these steps:

1. Open the Profiles view.
2. Select the appropriate product type in the profile to which you want to add a data set.
3. Right-click and select Add Data Set.

The New Data Set Definition dialog opens.
4. Type a fully qualified data set name of the dump repository or index and click Finish.

The new data set is created and added to the list of data sets under product that you specified.

Use a Default Data Set
You can use the default repository or index data set defined by the product run-time options.

Follow these steps:

1. Open the Profiles view.
2. Right-click a SymDump Batch or System node in any profile and select Add Data Set.

The Add New Data Set dialog opens.
3. Select the Use Default Data Set check box only; Do not add a data set name.
4. Click Finish.

A Default data set entry appears in the index/repository data set list. Select the default data set check box to use the
system default data set.

NOTE
This option is only available for SymDump Batch and SymDump System nodes.

Update the Details of an Existing Data Set

You can modify the name of an existing data set using the Update Data Set Definitions dialog.

Follow these steps:

1. Open the Profiles view.
2. Right-click the data set to edit and select Update Data Set.

The Update Data Set Definition dialog opens.
3. Type a fully qualified repository or index data set name and click Finish.

Your changes are saved and the Profiles view refreshes to show the updated data set name.

Add Protsym Data Sets to a Profile
You can add Protsym data sets to a selected profile. A Protsym data set is a VSAM relative-record data set (RRDS) used
to store symbolic information for reporting.

Follow these steps:

1. Open the Profiles view.
2. Right-click a Protsym node and select Add Data Set.
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The Add New Data Set dialog opens.
3. Type a fully qualified data set name.
4. Check the following boxes as necessary.
Use as Dynamic Symbolic Support receiver

Initiates or causes Endevor to dynamically load program listings into the specified Protsym file if a matching listing
is not found in any of the Protsym files specified in the node.
When a file is selected as a receiver, this field will be disabled and the name of this field will change to display the
currently specified receiver file. Only one file is selected as the Dynamic Symbolic Support (DSS) receiver file in
each SymDump profile.

NOTE
To use DSS, the CA Source Control Manager and the CA SCM FOOTPRINT options must be active
when the abending program was compiled or assembled. The program listings must also be managed
by Endevor.

Always refresh non-LE enabled Assembler symbolics
Initiates or causes Endevor to always load non-LE enabled assembler program listings because there is no date/
time stamp in the associated program load module that can be used for match verification.

5. Click Finish.
The details of the new Protsym data set are saved and the Profiles view refreshes to show the updated data set name

Delete Data Sets from a Profile
You can delete data sets from a profile displayed in the Profiles view if you are not using it. You can delete multiple data
sets from SymDump.

Follow these steps:

1. Open the Profiles view.
2. Right-click the data set to delete and select Delete Profile.

NOTE
You can use Ctrl-click or Shift-click to delete multiple data sets.

The Confirm Delete dialog opens requesting you to confirm the deletion.
3. Click OK.

The data set is deleted from the server and the Profiles view refreshes to show the list of available data sets.

Customizing SymDump
This chapter describes how to customize the appearance and behavior of SymDump.

Set Preferences for SymDump

You can set the default preferences for viewing all internal trace records, other informational messages and errors
generated by SymDump.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens the SymDump page.

2. Complete the following fields as necessary:
Logging Levels

Indicates how you want to display the errors in the Error Log view. Select one of the following options from the
drop-down list:
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Errors Only
View only errors in the Error Log view.

Warnings
View both warning messages and errors in the Error Log view.

Trace
View all internal trace records, warning messages, and errors in the Error Log view.

Debugging
Lets you view all debugging actions, internal trace records, warning messages, and errors in the Error
Log view.

Size of Memory Fetch
Specifies the maximum number of bytes that will be retrieved for each memory retrieval of memory.
Default: 1536
Limits: 512 - 4096

NOTE
This value is ignored for SymDump System requests where the value will always be 1536 (0x600) bytes.

Always close dump without prompting
Lets you change the preferences to modify the behavior of Close Dump Dialog by selecting or clearing the check
box.

3. Click Apply to save the settings. Click OK to close the Preferences dialog.

The application saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, and click Restore Defaults, click Apply, and then click OK.

Set Preferences for Close Dump Dialog
By default, when you close the Dumps, a confirmation message is displayed asking you to confirm whether you want to
close the Dumps. You can change the preferences to modify the behavior.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Select SymDump.
The Preferences dialog opens the SymDump page.

3. Clear the Always Close dumps without prompting option.
4. Click Apply to save settings.
5. Click OK.

SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding logon sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, click Restore Defaults, click Apply, and then click OK.

Set General Preferences for SymDump
You can set the general preferences for SymDump using the Preferences dialog.

 41



 SymDump® Eclipse Help 11.0

NOTE
Expanding the General folder displays the Appearance, Editors, and Keys options.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Select General.
The Preferences dialog opens the General page.

3. Change the default settings for the following fields to suit your needs:
Keep next/previous editor, view and perspectives dialog open

Lets you access the pages on a dialog that you have previously seen for an active project. Click the Previous or
Next arrow button to see the previous or next page respectively.

NOTE
When you close the dialog and reopen it, the previously stored page order will not be available.

Specifies that the Program Listing area and the view cycle dialogs remain open after you release their activation
keys. Usually, the dialogs or menus close as soon as you release the activation keys (such as Ctrl+F7).
Default: Off
When this preference is checked, you can use the key combination Ctrl +F7 on the SymDump main window to
keep the pop-up menu listing those views that can be opened, when you release the control keys. When this
check box is cleared, the pop-up menu remains visible only as long as you hold down the control key. If you
release the control key, the pop-up menu closes.

Open mode
Specifies the default behavior for opening views and programs in the Program Listing area. You can select one of
the following methods for opening these resources:
Double click

Specifies a single-click to select a resource and a double-click to open that resource in the Program
Listing area.

Single click
(Select on hover)
Specifies hovering the mouse over a resource to select it and single-clicking on the resource to open it in
the Program Listing area.

Single click
(Open when using arrow keys)
Specifies using the arrow keys to select a resource and automatically opening it in the Program Listing
area.

Default: Double click

NOTE
The effect of these selections may vary depending on the view that has the focus.

4. Click Apply to save the settings.
5. Click OK.

NOTE
SymDump does not support Always run in background and Show Heap Status fields in this dialog.

Set Text Editor Appearance Preferences
You can specify the settings that affect the general appearance and behavior of the text editors. You can also specify the
color and font settings used in the text editors.
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Follow these steps:

1. Select Window, Preferences. The Preferences dialog opens.
2. Expand General and select Appearance.

The Preferences dialog opens the Appearance page.
3. Select the Override presentation settings box. This action invokes the Editor tab positions, View tab positions,

Perspective switcher positions, and other fields. Edit the default settings for these fields as needed.
Editor tab positions

Changes the location of the tabs in the Program Listing area. Possible values are as follows:
Top

Indicates that the tabs for individual program listings appear at the top of the Program Listing area.
Bottom

Indicates that the tabs for individual program listings appear at the bottom of the Program Listing area.
Default: Top

View tab positions
Changes the location of tabs in all views.
Top

Indicates that the tabs for individual views appear at the top of the view.
Bottom

Indicates that the tabs for individual views appear at the bottom of the view.
Default: Top

NOTE
SymDump does not support the following fields and options. Broadcom is not responsible for any results if
you use these fields.

4. Click Apply to save the settings.
5. Click OK.

SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, click Restore Defaults, and then click OK.

Set Preferences for Colors and Fonts

You can specify the colors and fonts that are used for basic items such as hyperlinks, text, error message text, and the
colors and fonts for the views and editors.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General, Appearance and select Colors and Fonts.
The Preferences dialog opens the Colors and Fonts page.

3. Expand the Basic or View and Editor Folders.
The default color and font settings for different components in each folder appear. A filled-square indicates a color
setting.

NOTE
When you select a color or font setting under the View and Editor Folders, you will see a preview of the
selected setting.
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4. Click OK.
SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, click Restore Defaults, and then click OK.

Set Color Preferences for Views and Folders

You can set your color preferences for a basic item, for example error message text, views, and folders. For example, you
can choose to use a particular foreground or background color for the SymDump views.

Follow these steps:

1. Select a color setting you want to change under Basic or View and Editor Folders.
This action enables the Edit button.

2. Click Edit.
The Color selection dialog opens.

3. Select a color you want to use and click OK to close the dialog.
The selected color appears in the filled-square to the left of the selected setting.

4. Click Apply to save the settings. Click OK.

SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, and click Restore Defaults, click Apply, and then click OK.

Set Preferences for Fonts

You can specify your own settings for the font that is used to display a basic item, view, and folder.

Follow these steps:

1. Select a font setting you want to change under Basic or View and Editor Folders.
This action enables the buttons on the right pane.

2. Click one of the following buttons in the right pane.
Use System Font

Lets the operating system automatically set the font to a reasonable value. For example, on Windows systems,
the operating system sets the font selected in the Control Panel.

Edit
Displays the Font selection dialog. Select the font that you want to use and click OK to close the dialog.

Reset
Applies the default settings for the selected font.

3. Click OK.
SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, click Restore Defaults, and then click OK.
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Set Program Listing Area Preferences
You can specify the settings that affect the general appearance and behavior of the Program Listing areas.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General and select Editors.
The Preferences dialog opens the Editors page.

3. Change the default settings for the following fields to suit your needs:
Size of recently opened files list

Controls the number of programs displayed in the Program Listing area.
Default: 4
Limits: 0 to 15

Show multiple editor tabs
Defines multiple program tabs in the Program Listing area.
Default: On

NOTE
When this preference is Off, Program Listing area contains one large tab and all programs that are not
visible are available only from the Show List drop-down menu.

Allow in-place system editors
Lets the editor to modify the contents of a program listing in the Program Listing area directly from the SymDump.
Default: On

Restore editor state on startup
Stores and reloads the Program Listing area with the last saved settings.
Default: On

Prompt to save on close even if still open elsewhere
Displays a save message to close the window automatically even when another application window for SymDump
is open.
Disables reusing programs in SymDump.
Default: On

Close editors automatically
Lets you close the window automatically even when another application window for SymDump has the same
program open.
Disables reusing programs in SymDump.
Default: Off

NOTE
Selecting this option enables the Number of opened editors before closing and When all editors are dirty
or pinned fields.

Number of opened editors before closing
Displays the number of programs you can use before recycling.
Default: 8

When all editors are dirty or pinned
Prompts a dialog to save and reuse programs or opens a new Program Listing area when all programs
are dirty or pinned. A dirty program has been updated, but not saved. A pinned program is docked.
Default: Prompt to save and reuse

4. Click Apply to save the settings. Click OK.
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NOTE
SymDump does not support the File Association or Content Types preferences.

SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, and click Restore Defaults, click Apply, and then click OK.

Set Preferences for Text Editors
To specify the settings that affect the general appearance and behavior of the text editors use the Preferences dialog.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General and select Editors, Text Editors.
The Preferences dialog opens the Text Editors page.

NOTE
SymDump does not support the settings for the following options for text editors: Accessibility, Annotations,
Hyperlinking, Linked mode, Quick Difference, and Spelling.

3. Change the default settings for the following fields to suit your needs:
Highlight current line

Highlights the current line in text editors.
Default: On

Show print margin
Displays the print margin. Checking this box enables the Print margin columns field.
Default: Off

Print margin columns
Lets you specify the print margin column.
Default: 80

Show line numbers
Displays line numbers on the left side of text editors.
Default: Off

Show range indicator
Displays the range indicator for text editors.
Default: On

Appearance color options
Lets you specify the color for the following values:

• Line number foreground
• Current line highlight
• Print margin
• Find scope
• Selection foreground color
• Selection background color
• Background color
• Foreground color
• Hyperlink
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NOTE
SymDump does not support the following fields and options and is not responsible for the results if you
choose to use any of these options.

4. Click OK.
SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, click Restore Defaults, and then click OK.

Set Accessibility Preferences

You can set caret positions in the editors. Carets are user defined points that blink when a user hovers over the line at
which the caret is set. Caret positions identify the location of a mouse cursor and help track the mouse cursor position on
the program listing.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General, Editors, Text Editors and select Accessibility.
The Preferences dialog opens the Accessibility page.

3. Change the default settings for the following fields to suit your needs:
Use custom caret

Allows SymDump to use custom caret tracking. Checking this box activates the Enable thick caret check box.
Enable thick caret

Specifies that thick carets can be used for custom caret tracking. Check the box if you want to use this
option.

Use characters to show changes in vertical ruler
Indicates that characters can be used on the vertical ruler to denote carets. Check the box if you want to use this
option.

4. Click OK.
SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, click Restore Defaults, and then click OK.

Set Annotations Preferences

You can set the annotations options for text editors using the Preferences dialog. The annotation settings affect the
appearance and location in which different annotations such as bookmarks and breakpoints are displayed in the Program
Listing area.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General, Editors, Text Editors and select Annotations.
The Preferences dialog opens the Annotations page.
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3. Change the default settings for the following fields to suit your needs:
Annotation Types

Lists the types of annotations that you can change.

NOTE
SymDump does not support the Annotation types Spelling Errors or Tasks.

Show in
Specifies the location in which the annotation type appears (in text with selected attributes, in the Overview ruler,
or in the Vertical ruler) in the Program Listing area, and the color of the annotation type.
Vertical ruler

Specifies that the annotation type appear on the vertical ruler.
Overview ruler

Specifies that the annotation type appear on the overview ruler.
Text As

Indicates that the annotation type appears as highlighted text or a squiggly line. Select this option and
specify Highlighted or Squiggly Line.

4. Click OK.
SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, click Restore Defaults, and then click OK.

Set Vertical Ruler Preferences

You can display the vertical ruler in the Program Listing area to see the line numbers for statements in the active program.

Follow these steps:

1. Display a program in the Program Listing area.
2. Select Window, Preferences.

The Preferences dialog opens.
3. Expand the General, Editors and select Text Editors.

The Preferences dialog opens Text Editors page.
4. Click the Show Line numbers check box to activate the ruler in the Program Listing area. Click Apply to save the

settings and click OK.
The Program Listing area displays a vertical rule showing the line numbers for all statements in the program.

Set Shortcut Key Preferences
To move around the SymDump main window use keyboard keys or key combinations.

You can modify the default shortcut keys assigned for certain functions in SymDump. The General Preference settings for
keys affect the key mapping or binding used to perform various functions in SymDump.

To see the shortcut keys, click Help, Key Assist. The Shortcut Keys window opens on the SymDump main window.

Key shortcuts that invoke commands or open views are not discussed in this online help. Some of these commands and
views exist because of the framework on which the interface was developed, but they do not perform any specific function
in the SymDump application. Broadcom does not support the use of these key shortcuts.
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NOTE
The Key mapping feature provides the ability to modify key assignments. SymDump does not support the
functionality of these key mappings.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General and select Keys.
The Preferences dialog opens the Keys page. This page lists the default key mappings for all commands and functions
in SymDump.

3. Select a scheme from the Scheme drop-down list. Choose SymDump, Default, or Emacs scheme.
The Keys page lists the command key sequences for the selected scheme. A table displays binding, action, and
category for each command key sequence.

4. Scroll or type the name of the command key sequence you want to edit.
The Preview pane shows the details such as name of the selected key sequence, description, binding, event when the
selected key works, and conflicts information.

5. Change the default settings for the selected key to suit your needs:
Name

Displays a description for the command key sequence. This is a non-editable field.
Description

Displays a description for the command key sequence. This is a non-editable field.
Binding

Displays the binding key combination for the command key sequence. Type the key sequence you want to assign
to the function in the Key Sequence, Name field. Click the arrow and select Backspace, Tab, or Shift+Tab to set
key combinations for the selected key sequence.

When
Displays a list of actions for command key sequences. Select the action when you want to initiate a selected key
sequence from the drop-down list.

Conflicts
Displays a conflicting key sequence that uses the same key combination as the selected command key sequence.
Change the value in the Binding field.

6. Click Apply to save the settings.
7. Click OK. SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding

sessions unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, click Restore Defaults, and then click OK.

Create a Copy of a Command Key Sequence
You can create a copy of a command key sequence and duplicate the settings for a similar function in SymDump.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General and select Keys.
The Preferences dialog opens the Keys page. This page lists the default key mappings for all commands and functions
in SymDump.

3. Select a scheme from the Scheme drop-down list. Choose SymDump, Default, or Emacs scheme.
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The Keys page lists the command key sequences for the selected scheme. A table displays binding, action, and
category for each command key sequence.

4. Scroll or type the name of the command key sequence.
The Preview pane shows the details such as name of the selected key sequence, description, binding, event when the
selected key works, and conflicts information.

5. Click Copy Command.
A new command key sequence is added to the pane showing the command key sequences.

6. Change the default settings for the selected key to suit your needs:
Name

Displays a description for the command key sequence. This is a non-editable field.
Description

Displays a description for the command key sequence. This is a non-editable field.
Binding

Displays the binding key combination for the command key sequence. Type the key sequence you want to assign
to the function in the Key Sequence, Name field. Click the arrow and select Backspace, Tab, or Shift+Tab to set
key combinations for the selected key sequence.

When
Displays a list of actions for command key sequences. Select the action when you want to initiate a selected key
sequence from the drop-down list.

Conflicts
Displays a conflicting key sequence that uses the same key combination as the selected command key sequence.
Change the value in the Binding field.

7. Click Apply to save the settings.
8. Click OK.

SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, and click Restore Defaults, click Apply, and then click OK.

Unbind a Command Key Sequence
You may want to remove the binding value from a function in SymDump and apply that binding value to another function.

NOTE
By default, the table on the Keys page lists only the command key sequences that contain binding settings.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General and select Keys.
The Preferences dialog opens the Keys page. This page lists the default key mappings for all commands and functions
in SymDump.

3. Select a scheme from the Scheme drop-down list. Choose SymDump, Default, or Emacs scheme.
The Keys page lists the command key sequences for the selected scheme. A table displays binding, action, and
category for each command key sequence.

4. Scroll or type the name of the command key sequence you want to unbind.
The Preview pane shows the details such as name of the selected key sequence, description, binding, event when the
selected key works, and conflicts information.
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5. Click Unbind Command.
This action removes the binding information from the selected command key sequence.

6. Click Apply to save the settings. Click OK.
SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, and click Restore Defaults, click Apply, and then click OK.

Restore the Settings for a Command Key Sequence
You can reload the default settings for a selected command key sequence, for example binding information and category.
This helps you to remove any previously saved settings from the selected command key sequence.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Expand General and select Keys.
The Preferences dialog opens the Keys page. This page lists the default key mappings for all commands and functions
in SymDump.

3. Select a scheme from the Scheme drop-down list. Choose SymDump, Default, or Emacs scheme.
The Keys page lists the command key sequences for the selected scheme. A table displays binding, action, and
category for each command key sequence.

4. Scroll or type the name of the command key sequence and then click the command key sequence.
The Preview pane shows the details such as name of the selected key sequence, description, binding, event when the
selected key works, and conflicts information.

5. Click Restore Command.
The default setting for the selected key is restored.

6. Click Apply to save the settings. Click OK.
SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, and click Restore Defaults, click Apply, and then click OK.

Set Help Preferences
You can specify the Help preferences that affect the way online help is displayed and determine whether an external
browser is used to display help information.

NOTE
If you do not specify use of an external help browser, SymDump uses an internal panel to host the web browser.

Follow these steps:

1. Select Window, Preferences.
The Preferences dialog opens.

2. Select Help.
The Preferences dialog opens the Help page.

3. Change the default settings for the following fields to suit your needs:
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Open help search
Specifies whether to open the help search page in a dynamic view panel or in a browser window.
Default: In a dynamic help view

Open help contents
Specifies whether to open the help contents page in the help browser window or in an external browser window.
Default: In the help browser

Open window context help
Specifies whether to open the context help for windows in a dynamic view panel or in a pop-up information box.
Default: In a dynamic help view

Open dialog context help
Specifies whether to open dialog context help in a dynamic help window or in a pop-up information box.
Default: In dialog tray

4. Click Apply to save the settings. Click OK.

SymDump saves the changes and closes the Preferences dialog. The changes are used in all succeeding sessions
unless you change the preferences again.

NOTE
You can restore the default configuration settings anytime on the Preferences dialog. To restore the default
settings, navigate to the page you want to restore, and click Restore Defaults, click Apply, and then click OK.

Using Help features
This section provides the information about accessibility features, instructions on how to use online and dynamic help and
cheat sheets.
Online Help

Find the relevant information using the search panel that is part of the internal online help system.
Dynamic Help

Access a documentation article related to a specific view or window using the question mark icon in the toolbar.
Cheat Sheets

Follow step-by-step-instructions and demos to learn how to perform a specific task.

Search Online Help
Activates the internal online Help view and displays the Search panel in which you can enter text that you want to search
for. Click Go to display all topics in the online documentation in which the search text appears.

Follow these steps:

1. Select Help, Search.
The Search dialog opens within the main window.

2. Enter the term or keyword you want to search for in the Search Expression field.
3. Click the arrow on the left to expand the scope for the search.
4. Check the Local copy box to search within local topics or click Default to set the default topics you want to search for.
5. Click Go.

The Search window displays the results of the search.
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Use Cheat Sheets
SymDump graphical user interface provides cheat sheets that are additional help options. Cheat sheets provide step-by-
step instructions for performing tasks. Cheat sheets also demonstrate some tasks such as opening a view from the main
window.

To use cheat sheets, click one of the following links:

Click to Restart
Reloads the cheat sheet to show the tasks listed in it.

Click to Perform
Demonstrates how to perform a particular task.

Click when complete
Closes the contents of the active task and opens the next task.

Use Default Sheets
SymDump provides a set of default cheat sheets for all users. The Cheat Sheets view shows the Setting up Profiles View
cheat sheet by default. You may want to launch a different cheat sheet available for use.

Follow these steps:

1. Click the View toolbar icon on the Cheat Sheets view toolbar and select Launch Other
The Cheat Sheet Selection dialog opens. The Select a cheat sheet from the list is the default option.

2. Select the cheat sheet you want to view and click OK.

The Cheat Sheets view opens displaying the selected cheat sheet.

Import Cheat Sheets
You can also import an already saved cheat sheet into SymDump.SymDump lets you import only files in .XML file format
as cheat sheets.

Follow these steps:

1. Click the View toolbar icon on the Cheat Sheets view toolbar and select Launch Other
The Cheat Sheet Selection dialog opens. The Select a cheat sheet from the list is the default option.

2. Choose the Select a cheat sheet from a file option.
This action enables the dropdown box and Browse button.

3. Click Browse to locate and select the cheat sheet you want to import and click Open.

NOTE
You can also select any previously imported files from the dropdown box if available.

4. Click OK.

The Cheat Sheets view opens displaying the imported cheat sheet.

Use Dynamic Help
In addition to the Help menu, you can access help related to a specific view using the ? icon in the toolbar.

NOTE
The Dynamic Help feature is supported only for the views in the SymDump main window. This feature is not
supported in the Program Listing area, window controls such as menu items or buttons, or toolbar icons.

The internal Dynamic Help view contains the following four pages that present help topics in different ways:
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Related Topics Page
Shows description and links to topics in the online documentation related to the current context. You can click
More Results to view more links.

All Topics Page
Displays the Table of Contents for the online SymDump documentation arranged in a tree hierarchy that you can
expand or collapse as needed.

Search Page
Lets you enter search text. When you click Go, SymDump performs the search and displays links in the online
documentation to the search hits and a summary of topic contents.

Bookmarks Page
Displays online Help topics that you mark as personal bookmarks.

Using Accessibility Features
Broadcom is committed to ensuring that all customers, regardless of ability, can successfully use its products and
supporting documentation to accomplish vital business tasks.

Using Accessibility Keys
You can navigate the SymDump main window using certain keyboard keys or key combinations. For example, you can
use the Tab key to move to controls (fields, buttons, check boxes, and so on) in a particular dialog or view and their
related icons.

To navigate the main toolbar on the SymDump main window or to tab out of views, use the Ctrl+Tab key combination.

Access the Menus
You can use shortcut keys for accessing menus on the SymDump main window. Most menus have assigned mnemonics
or accelerator keys for selecting menu options and submenu options. You can also use the arrow keys to move to and
select options on menus and submenus.

You can access the various menus using the following keys:

Key or Key Combination Description
F10 Accesses the menus on the main menu bar.
Shift+F10 Displays the pop-up menu for the current view. Note that this

shortcut depends on your window manager, but typically it is Shift
+F10.

Ctrl+F10 Opens the drop-down menu for the current view if one exists. For
Program Listing area, Ctrl+F10 opens the menu for the vertical
ruler on the left of the Program Listing area.

Alt+mnemonic Activates a menu on the main menu bar. For example, Alt+W
activates the Window menu.

Alt Gives the focus to the menu bar.

Access Controls
You can switch between toolbar icons and items within a particular view using the Tab key. You can also use the Tab key
to switch between the fields and buttons on a dialog.

To quickly move within a dialog, use the following techniques:
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• Click Tab to highlight a field.
• Press one of the following keys to populate the related fields:
Space

Checks or unchecks a check box.
Up or Down Arrow

Selects an option button or a value in a drop-down list.
Enter

Performs a button-click action.
• To expand the nodes within a tree structure displayed in a dialog, highlight the Expand All button and press Enter.
• Press Enter when you complete populating the required fields.

Switch Between Program Listing Area and Other Views
You can switch between the Program Listing area and other views using Ctrl key-function key combination. All switch key
combinations recall the last item you selected to provide rapid switching between two items.

You can also use the following key combinations to switch between active programs in the Program Listing area:

Ctrl+Home
Highlights the first line of code within the active program

Ctrl+End
Highlights the last line of code within the active program

Ctrl+PageUp
and Ctrl+PageDown
Switches between the programs that are open or activates the drop-down menu listing the programs opened for
the active batch or CICS session

Ctrl+F
key combination
Searches the program for a selected keyword using the Find dialog
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Product Accessibility Features
Broadcom is committed to ensuring that all customers can successfully use its products and supporting documentation to
accomplish business tasks. Enable Windows accessibility mode to optimize contrast in the user interface and activate a
screen reader for those users who need assistance.

NOTE

 SymDump accessibility features are best when used with Internet Explorer 10 and higher, and with the Job
Access With Speech (JAWS) screen reader.

System Accessibility Inheritance

SymDump inherits accessibility enhancements from Windows-based and Macintosh-based environments in the following
areas:

Mouse

You can use the following options to make your mouse faster and easier to use:

Click Speed
Choose how fast to click the mouse button to make a selection.

Click Lock
Highlight or drag without holding down the mouse button.

Reverse Action
Reverse the functions controlled by the left and right mouse keys.

Blink Rate
Choose how fast the cursor blinks or if it blinks at all.

Pointer Options
Do the following:

• Hide the pointer while typing
• Show the location of the pointer
• Set the speed that the pointer moves on the screen
• Choose the pointer's size and color for increased visibility
• Move the pointer to a default location in a dialog box

Keyboard

You can make the following keyboard adjustments:

Repeat Rate
Set how quickly a character repeats when a key is pressed.

Tones
Hear tones when pressing certain keys.

Sticky Keys
Use keyboard shortcuts or type capital letters without needing to press more than one key at once.
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Sound

Use sound as an alternative to visual information or to make computer sounds easier to hear or distinguish by adjusting
the following options:

Volume
Turn the computer sound up or down.

Text-to-Speech
Hear command options and text read aloud.

Warnings
Display visual warnings.

Notices
Provides you aural or visual cues when accessibility features are enabled or disabled.

Schemes
Associate computer sounds with specific system events.

Captions
Display captions for speech and sounds.

Display

To increase visibility on your computer display, you can adjust the following options:

Font style, color, and size of items
Choose font color, size, and other visual combinations.

Screen resolution
Change the pixel count to enlarge objects on the screen.

Cursor width and blink rate
Make the cursor easier to find or minimize its blinking.

Icon size
Make icons larger for visibility or smaller for increased screen space.

High contrast schemes
Select color combinations that are easier to see.

NOTE
 This information applies to Windows-based and Macintosh-based applications. Java applications run on many
host operating systems, some of which already have assistive technologies available to them. For these existing
assistive technologies to provide access to programs written in JPL, they need a bridge between themselves
in their native environments and the Java Accessibility support that is available from within the Java Virtual
Machine (Java VM). This bridge has one end in the Java VM and the other on the native operating systems, so it
will be slightly different for each platform it bridges to. Oracle is currently developing both the JPL and the Win32
sides of this bridge.

Configure Accessibility in the GUI

Follow these steps:

1. Go to Window, Preferences, and expand General, Editors, Text Editors and click Accessibility.
The Accessibility dialog opens. 

2. Select the appropriate Accessibility check boxes:
Use custom caret

Default: Selected
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Enable thick caret
Default: Selected

Use characters to show changes in vertical ruler
Default: Cleared

Use saturated colors in overview ruler
Default: Cleared

3. To save your changes, click Apply or OK.

Keyboard Shortcuts

In the SymDump GUI you can customize and create shortcut for many program commands. The following table shows the
default keyboard shortcuts for actions in the SymDump GUI.

File Command Shortcuts

Command Binding Available When
Properties Alt+Enter In Windows
Close Ctrl+F4 In Windows
Rename F2 In Windows
New menu Alt+Shift+N In Windows
Close All Ctrl+Shift+W In Windows
Print Ctrl+P In Windows
New Ctrl+N In Windows
Close Ctrl+W In Windows
Save Ctrl+S In Windows
Close All Ctrl+Shift+F4 In Windows
Refresh F5 In Windows
Save All Ctrl+Shift+S In Windows

Edit Command Shortcuts

Command Binding Available When
Find Next Ctrl+K Editing Text
Paste Ctrl+V In Dialogs and Windows
Paste Shift+Insert In Dialogs and Windows
Copy Ctrl+C In Dialogs and Windows
Delete Delete In Windows
Copy Ctrl+Insert In Dialogs and Windows
Cut Ctrl+X In Dialogs and Windows
Incremental Find Reverse Ctrl+Shift+J Editing Text
Find Previous Ctrl+Shift+K Editing Text
Incremental Find Ctrl+J Editing Text
Cut Shift+Delete In Dialogs and Windows
Quick Diff Toggle Ctrl+Shift+Q Editing Text
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Toggle Insert Mode Ctrl+Shift+Insert Editing Text
Content Assist Ctrl+Space In Dialogs and Windows
Select All Ctrl+A In Dialogs and Windows
Toggle Block Selection Alt+Shift+A Editing Text
Context Information Ctrl+Shift+Space In Dialogs and Windows
Find and Replace Ctrl+F In Windows
Redo Ctrl+Y In Dialogs and Windows
Undo Ctrl+Z In Dialogs and Windows
Quick Fix Ctrl+1 In Dialogs and Windows
Word Completion Alt+/ Editing Text

Navigation Command Shortcuts

Command Binding Available When
Previous Ctrl+, In Windows
Collapse All Ctrl+Shift+Numpad_Divide In Windows
Show In... Alt+Shift+W In Windows
Next Page Alt+F7 In Windows
Last Edit Location Ctrl+Q In Windows
Previous Sub-Tab Alt+PageUp In Dialogs and Windows
Go to Line Ctrl+L Editing Text
Previous Page Alt+Shift+F7 In Windows
Next Ctrl+. In Windows
Next Sub-Tab Alt+PageDown In Dialogs and Windows
Expand All Ctrl+Shift+Numpad_Multiply In Windows
Forward History Alt+Right In Windows

Text Editing Command Shortcuts

Command Binding Available When
To Upper Case Ctrl+Shift+X Editing Text
Select Next Word Ctrl+Shift+Right Editing Text
Join Lines Ctrl+Alt+J Editing Text
Select Line End Shift+End Editing Text
Line Start Home Editing Text
Text End Ctrl+End Editing Text
Collapse All Ctrl+Shift+Numpad_Divide Editing Text
Text Start Ctrl+Home Editing Text
Toggle Overwrite Insert Editing Text
Select Line Start Shift+Home Editing Text
Insert Line Above Current Line Ctrl+Shift+Enter Editing Text
Next Word Ctrl+Right Editing Text
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Reset Structure Ctrl+Shift+Numpad_Multiply Editing Text
Show Tooltip Description F2 Editing Text
Expand All Ctrl+Numpad_Multiply Editing Text
Delete Line Ctrl+D Editing Text
Duplicate Lines Ctrl+Alt+Up Editing Text
Delete Previous Word Ctrl+Backspace Editing Text
Move Lines Up Alt+Up Editing Text
Copy Lines Ctrl+Alt+Down Editing Text
Delete to End of Line Ctrl+Shift+Delete Editing Text
To Lower Case Ctrl+Shift+Y Editing Text
Insert Line Below Current Line Shift+Enter Editing Text
Toggle Folding Ctrl+Numpad_Divide Editing Text
Move Lines Down Alt+Down Editing Text
Select Previous Word Ctrl+Shift+Left Editing Text
Previous Word Ctrl+Left Editing Text
Line End End Editing Text
Scroll Line Up Ctrl+Up Editing Text
Expand Ctrl+Numpad_Add Editing Text
Delete Next Word Ctrl+Delete Editing Text
Scroll Line Down Ctrl+Down Editing Text

Views Command Shortcuts

Command Binding Available When
Show View (Error Log) Alt+Shift+Q, L In Windows
Show View Alt+Shift+Q, Q In Windows
Show View (Outline) Alt+Shift+Q, O In Windows
Show View (Console) Alt+Shift+Q, C In Windows
Show View (Cheat Sheets) Alt+Shift+Q, H In Windows

Window Command Shortcuts

Command Binding Available When
Next Editor Ctrl+F6 In Windows
Show Ruler Context Menu Ctrl+F10 Editing Text
Quick Switch Editor Ctrl+E In Windows
Quick Access Ctrl+3 In Windows
Switch to Editor Ctrl+Shift+E In Windows
Activate Editor F12 In Windows
Maximize Active View or Editor Ctrl+M In Windows
Show Key Assist Ctrl+Shift+L In Dialogs and Windows
Previous View Ctrl+Shift+F7 In Windows
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Show Contributing Plug-in Alt+Shift+F3 In Dialogs and Windows
Next View Ctrl+F7 In Windows
Previous Editor Ctrl+Shift+F6 In Windows
Show View Menu Ctrl+F10 In Dialogs and Windows
Show System Menu Alt+- In Windows
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Documentation Legal Notice
This Documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred
to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by Broadcom
at any time. This Documentation is proprietary information of Broadcom and may not be copied, transferred, reproduced,
disclosed, modified or duplicated, in whole or in part, without the prior written consent of Broadcom.

If you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make
available a reasonable number of copies of the Documentation for internal use by you and your employees in connection
with that software, provided that all Broadcom copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the
applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your
responsibility to certify in writing to Broadcom that all copies and partial copies of the Documentation have been returned
to Broadcom or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, BROADCOM PROVIDES THIS DOCUMENTATION “AS
IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL
BROADCOM BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT,
FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST
INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF BROADCOM IS EXPRESSLY
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and
such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is Broadcom Inc.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the
restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)
(3), as applicable, or their successors.

Copyright © 2005-2022 Broadcom. All Rights Reserved. The term “Broadcom” refers to Broadcom Inc. and/or its
subsidiaries. All trademarks, trade names, service marks, and logos referenced herein belong to their respective
companies.
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